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1.1. ABOUT 

ArCADia-REINFORCED CONCRETE COLUMN Application is designed for structure designers. The 

Application was designed to maximally support the user during the development of reinforced 

concrete column drawings in CAD applications. ArCADia-REINFORCED CONCRETE COLUMN is an 

object-based Application which uses 2D data entered by the user (in the form of views and sections) 

to generate a 3D model of column reinforcement which may be freely modified and which enables, for 

example, the new sections to be created. The element reinforcement designing with this Application 

is in line with requirements of EN 1992-1-1 Eurocode 2: September 2008. The Application enables the 

designer to enter the reinforcement data manually and also captures these data directly from 

calculation applications: EuroFerroConcrete module of R3D3 3D Frame and R2D2 2D Frame software, 

and Reinforced concrete column PN-EN of Constructor system. It is also possible to copy selected, 

already completed column from the same or prepared previously file. 

1.2. SOFTWARE BASIC FEATURES AND CAPABILITIES 

ArCADia-REINFORCED CONCRETE COLUMN software features and capabilities are as follows: 

 The ability to design multiple columns within a single file. 

 The ability to create a new file by copying of finished columns from previously completed 

drawings or copying columns within the same file. 

 The ability to design the element's geometry and reinforcement in two or four side primary 

views and arbitrary number of assumed column sections. 

 Full control over a drawing visibility and printing of views and sections along with their 

elements, and the possibility to switch between them during working with the model. 

 Non-limited moving and adding of column new sections. 

 The ability to create almost any shape of a column section: rectangular, round, angled, T-

shaped, C-shaped, Z-shaped and I-shaped along with adjoining elements in the top section of 

a column: transoms and column from upper level or transoms reaching its height. 

 In case of rectangular section columns, support for automatic creation of longitudinal 

reinforcement with the option of its automatic bending into the transoms or inserting it into 

the upper level column. 

 Automatic creation of rectangular section column transversal reinforcement in form of two- 

and four-legged stirrups, distributed in the areas defined by the user. 

 Automatic creation of column typical transversal reinforcement for other shapes of section. 

 Change of four-legged stirrup direction within the column section. 

 The reinforcement dimensioning available in mm or cm units, with adjustable accuracy. 

 Required bend radii of rebars are automatically taken into consideration. 

 The anchoring lengths of longitudinal rebars are automatically taken into consideration when 

they are bent into the transoms and inserted into the upper level column, in case of 

rectangular and round columns. 

 The cover of longitudinal and transversal reinforcement being distributed within the 

reinforced element is automatically taken into account. 
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 The ability to design free-shape rebars. 

 The rebar shape and properties are editable. 

 The editing tools enable the reinforcement to be freely located within the Views and Section 

of the element. 

 Automatic extraction of rebars along with their dimensions and descriptions (rebar details). 

 The rebar descriptions may be placed in any location within the Views and Sections of 

elements. 

 Automated and continuous numbering of each rebar within the single file. 

 The dimensioning geometry of column may be freely modified. 

 Automatic creation and modification of reinforcement steel list on the basis of created 

reinforcement model (The list covering the single element or whole drawing). 

 Automatic generation of reinforced column model on the basis of calculation carried out in 

EuroFerroConcrete module of R3D3 3D Frame and R2D2 2D Frame Application and in 

Reinforced concrete column PN-EN module of Constructor Application. 

 3D view of the generated model of column reinforcement. 

1.3. APPLICATION GENERAL SPECIFICATION 

ArCADia-REINFORCED CONCRETE COLUMN Application is a part of general, object-oriented system 

aiding designers' works and at the same it is the first module dedicated to structures. It is designed to 

develop detailed design documentation for structures made of reinforced concrete monolithic 

columns. It may be used in two primary operation modes: 

 As standalone Application designed to develop a detailed design documentation for 

reinforced concrete monolithic columns. 

 As automated platform designed to capture calculation results from EuroFerroConcrete 

module of R3D3 3D Frame and R2D2 2D Frame software and from Reinforced concrete 

column PN-EN of Constructor system, enabling their graphical representation in form of 

reinforced column 3D model which can be further modified. 

By introduction of column elements into the software (shape, transversal and longitudinal 

reinforcement) we create reinforced column spatial model, which may be displayed in 3D view 

whenever the user desires it. This model is generated from data entered by the user in form of 2D 

column views and sections. By default the Application opens two views and one section. The user is 

able to delete any view/section or add the new one in the selected position. The model elements 

(dimensioned column, column adjoining elements, longitudinal and transversal reinforcement) can be 

placed only in the one, active view or section (in other the elements are generated automatically 

according to their localization in the model, however the annotations and dimensions are omitted).  

The user can freely switch between the views or section. Along with the model elements, the project 

includes other elements, not related directly with views or sections. These are detail views of rebars 

(so called "extracted" rebars), reinforcement steel list and title block. The project elements available 

in the application we may divide into 3 main groups: 
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 The model elements, the localization of which is represented in every view and section. 

These elements are: column shape and column adjoining elements, longitudinal and 

transversal reinforcement. 

 Additional view elements not present in the model, the localization of which is not 

represented, linked to the particular view or section. These elements are: rebar annotations 

and dimensions. 

 Additional elements not present in the model and not linked to any view or section. These 

elements are: annotations regarding rebar details, reinforcement steel list and title block. 

Within a single document the user may insert few different types of columns. The reinforcement used 

in the model may be dimensioned in mm or cm. The rebars are assigned with numbers automatically, 

and, in general, the user has no influence on this process. The numeration is done sequentially and 

always concerns every rebar of the model within the single file/document, irrespectively of whether 

the rebars belong to single or more columns. 

1.4. APPLICATION REQUIREMENTS AND CONSTRAINS 

ArCADia-REINFORCED CONCRETE COLUMN Application is not a standalone application and needs a 

CAD software (ArCADia-INTELLICAD, ArCADia-START or AutoCAD) to be installed otherwise it cannot 

be run. When working in constructional mode of ArCADia-REINFORCED CONCRETE COLUMN module, 

the access to functions of other modules (e.g. Architecture) operating in the floor or building mode is 

blocked, because we are working in the structure detailed drawing mode. The same rule applies in the 

reverse situation - when working in the floor mode, the access to the functions of structure detailed 

drawing mode is blocked. Therefore, in active constructional mode, when you want to go back to work 

in e.g. Architecture in the floor mode, you must each time create a new project (file). The above not 

applies to the following general functions of whole ArCADia system: Project Manager, 3D View, 

Options etc., which are available in both modes, however their functioning may be slightly different 

due to the module specification. 
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2. INSTALLING AND RUNNING THE 

APPLICATION 
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2.1. HARDWARE REQUIREMENTS 

 Pentium IV PC (PIV D recommended) 

 2 GB RAM (4 GB recommended) 

 Approximately 1GB of free HDD space for the installation 

 DirectX 9.0 compatible graphics card 

 Windows Vista 32/64-bit OS, Windows 7 32/64-bit or Windows 8 32/64-bit 

 DVD-ROM drive 

2.2. INSTALLING 

The Application installation is started automatically, when the CD is inserted into the CD drive. The 

installation should be started manually, if the Autostart function is disabled. Explore the CD folder (My 

Computer/CD drive), and run Setup.exe. Once the installation is started, proceed according to the 

instructions displayed on the screen. 

2.3. RUNNING 

The Application may be initialized by double-click on the CAD software icon, which generally may be 

found on the desktop, and then selecting one of the icons on the ribbon or toolbar of ArCADia-

REINFORCED CONCRETE COLUMN application. 

2.4. OPENING PROJECT (CAD) 

You can open any of the following files:  

 Standard DWG file.  

 It is possible to use any of example drawings delivered with ArCADia-INTELLICAD.  

 Exchange file format DXF.  

 Network file format DWF.  

 Drawing templates DWT.  

To open recently used drawing in the fastest way, select File > <file name>. The Application remembers 

names of four recently opened drawings. To open quickly a drawing from dialogue box, Open the 

drawing by double-clicking on its name. 

It is possible to open a drawing during browsing of drawing files with Windows Explorer. You just have 

to double-click on a file to open it in ArCADia-INTELLICAD. In order to facilitate drawing identification 

during browsing of files, the miniatures showing their contents are displayed. 

The method of opening existing drawing 

 Choose one of the following methods: 

 Select file > Open. 
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 Click Open tool on Standard toolbar. 

 Write "open" and then push Enter.  

 Set file type to the type of your interest.  

 Select folder containing a desired drawing.  

 Use one of the following procedures:  

 Select the drawing you want to open and click Open.  

 Double-click on the drawing you want to open.  

If the drawing requires password, enter the password, click on OK to check the password, and then 

click on Open. 

2.5. SAVING PROJECT (CAD) 

Drawing may be saved any time. 

Use one of the following method to save a drawing: 

 Click Save Standard toolbar. 

 Select File > Save. 

 Write "save" and then push Enter. 

 Write "qsave" and then push Enter. 

When saving the drawing for the first time, the Application opens dialogue box "Save drawing as", 

which allows the user to choose target folder and drawing name. You can give any name to the drawing 

saved for the first time. To save the drawing under the other name later, select again option File > Save 

as, and enter the new name. 

2.6. AUTOSAVE AND BACK-UP COPY (CAD) 

Save your drawing files as often as it possible in order to avoid loss of data in case of power failure or 

system error. The Application may be configured to auto save the drawing periodically. Autosave 

setting determines time period (in minutes) between auto saves. The application resets this timer 

every time user save the drawing file. 

When Autosave function is enabled, the Application makes a drawing copy. This file is stored in a 

directory specified in Options > Paths/Files> Temporary file, and has an extension defined in the box 

Extension of drawing autosave file (SV$ by default). 

The method of configuring ArCADia-INTELLICAD for drawing auto saving 

1. Do one of the following: 

 Select Tools > Options. 

 Write config and then push Enter. 

2. Click on tab General. 
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3. In the Autosave area tick the check box in order to activate the Autosave function and set the 

auto saving frequency. 

4. Click on OK. 
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3. WORKING WITH THE APPLICATION 
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3.1. ARCADIA-REINFORCED CONCRETE COLUMN TOOLBAR AND 

RIBBON 

 

  

Fig. 1 The main ArCADia-REINFORCED CONCRETE COLUMN toolbar in AutoCAD and ArCADia-
INTELLICAD software 

The appearance of the main toolbar in CAD applications – AutoCAD, ArCADia-INTELLICAD is shown 

below. It offers the following functions: 

Icon:  

Function 

name: 

 Function description: 

 - isa_rcc_ip - Inserts column 

 - isa_rcc_xmlis - Inserts complete column from xml file 

 - isa_rcc_ihfp - Inserts column of upper level 

 - isa_rcc_isb - Inserts transom 

  - isa_rcc_isls - Inserts single stirrup 

 - isa_rcc_ils - Inserts stirrup block 

 - isa_rcc_iar - Inserts automatic rebar block 

 - isa_rcc_isar - Inserts single automatic rebar 

 - isa_rcc_ir - Inserts user-defined rebar shape 

 - isa_rcc_ird - Inserts rebar detail 

 - isa_rcc_iard - Inserts details for all rebars 

 - isa_rcc_igl - Inserts rebar descriptions 

 - isa_rcc_idm - Inserts freely chosen dimension 

 - isa_rcc_isl - Inserts list of steels used in the project 
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 - isa_rcc_islb - Inserts list of steels used in the structural element 

 - isa_rcc_isv_n - Inserts front view 

 - isa_rcc_isv_s - Inserts rear view 

 - isa_rcc_isv_e - Inserts left-side view 

 - isa_rcc_isv_w - Inserts right-side view 

 - isa_rcc_icv_g - Insert section 

 - isa_rcc_av - Activates selected construction view 

 - isa_rcc_help - Opens help 

 

 

Fig. 2 Main ribbon of ArCADia-START with ArCADia-REINFORCED CONCRETE COLUMN application 

The appearance of main ribbon of ArCADia-START with ArCADia - REINFORCED CONCRETE COLUMN 

is shown above. It offers the following functions:  

*BIM – options available to ArCADia BIM license holders, i.e. after purchasing one of the following 

programs: ArCADia, ArCADia AC, ArCADia LT or ArCADia PLUS. 

 

Icon Option Description *BIM 

 
Column Inserts column. X 

 
Column from XML Inserts complete column from xml file. X 

 
Upper level column Inserts column of upper level. X 

 Transom Inserts transom. X 
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 Set of stirrup Inserts stirrup block. X 

 
Stirrup Inserts single stirrup. X 

 
Group of rebar  Inserts automatic rebar block. X 

 
Rebar Inserts single automatic rebar. X 

 
Any shape rebar  Inserts user-defined rebar shape. X 

 
Rebar details Inserts rebar detail. X 

 
All rebar details Inserts details for all rebars. X 

 
Rebars description Inserts rebar descriptions. X 

 
Dimension Inserts freely chosen dimension. X 

 
Steel list Inserts list of steels used in the project. X 

 
Item steel list Inserts list of steels used in the structural element. X 

 
Front view Inserts front view. X 

 
Back view Inserts rear view. X 

 
Left view Inserts left-side view. X 

 
Right view Inserts right-side view. X 

 
Cross-section Insert section. X 

 
Activate Activates selected construction view. X 

 Help Displays the help window. X 
 

3.2. ARCADIA-REINFORCED CONCRETE COLUMN SETTINGS AND 

OPTIONS 

The general software settings may be found in Options window of ArCADia-REINFORCED CONCRETE 

COLUMN module. 
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Fig. 3 Options window of ArCADia Construction module 

The Options window incorporates basic settings relating to the presentation of reinforcement within 

the file/document. These are the following parameters (in the order of appearance): 

Reinforcement bend radius – determines for which reinforcements the bend radius are to be visible: 

 No visible bend radius. 

 All visible. 

 Visible only for reinforcement of diameter larger or equal to. 

Bending radius value – determines the rebar bending radius value 

 Basic (2 x  for a reinforcement diameter of ≤ 16 mm and 3.5 x  for a reinforcement diameter 

of > 16 mm) 

 Increased – as per the formula (8.1) in the PN-EN 1992-1-1 standard. 

Hooks in reinforcement – due to the fact of using only ribbed steel in the Application, the shape of 

hooks relates generally only to stirrups (for other rebars, the possible hook must be introduced 

individually): 

 At the angle of 90. 

 At the angle of 30. 
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Length unit used in rebar details, descriptions and dimensions – the parameter which enables the 

user to select desired unit for dimensioning of reinforcement and element, as well as to set its possible 

rounding off with 5 mm span (applies to rebar details and descriptions): 

 In millimetres (with possible 5 mm rounding off).  

 In centimetres (with possible 5 mm rounding off). 

Arc length in rebar details – the parameter which enables the user to define for which reinforcements 

the arc lengths are to be visible when the bend radii are used: 

 Visible for rebars (longitudinal). 

 Visible for stirrups. 

Rebar numbering: 

 Common numbering of all bars in the document – subsequent numbers for all bars in the entire 

document, a list of reinforcement steel for the entire document or a single structural element. 

 Separate numbers for the bards in each structural element – subsequent numbers for all bars 

in the element, starting from 1 for each element, thus providing the same numbers to different 

bars in the document. List of reinforcement steel only for a single structural element. 

If the user selects bend radius visibility for rebars of diameters covering also the stirrups and 

simultaneously enables arc visibility only for longitudinal rebars, the arc length for the stirrup will be 

added to both legs (divided equally) of the stirrup adjacent to this arc . 

The column model inserted with default settings into the drawing, will be represented in real scale, for 

which one unit from the drawing corresponds to one actual centimetre, independently from 

dimensioning units set in Options, described above. The user is able to change the drawing unit any 

time during designing (e.g. to millimetres) by opening Properties window for selected View anchor – 

Layout 1. 
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Fig. 4 The element Properties window for View anchor 

The change of the drawing unit (e.g. from centimetres to millimetres) changes the scale of whole 

drawing (model, descriptions, dimensions, etc.) but does not change the dimensioning method, 

dimension line values and rebar details. 

All the options and settings described above relate always to all the project elements used within the 

drawing. 

3.3. PROJECT MANAGER AND 3D VIEW 

After adding the column to the document, in Project Manager window for ArCADia-REINFORCED 

CONCRETE COLUMN module, two available views (front and rear view) and column section are visible 

by the default in the layout. Double-click on the view or section activates this view or section. The 

active view is displayed in Project Manager as bold text.  You may delete the individual model elements 

or their views in Manager, the "tree" shown below (from context menu of the right mouse button). 

You may set visibility, block position or exclude from plotting the model elements included in the 

individual views.  
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Fig. 5 Project Manager window 

Switching to 3D View tab in Project Manager window activates 3D view window of column model 

containing the designed reinforcement. After that, the individual model components in Project 

Manager may be set visible or invisible, it is possible to adjust their transparency etc. If single 

document contains few different columns, the model of only one column, the same which is active in 

Project Manager, in 3D View tab will be visible in 3D View at given time. To switch the activity status 

for the particular column in Project Manager in 3D View, click on the icon of appropriate column. 
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Fig. 6 3D View window for column 

3.4. WORKING WITH VIEWS AND INSERTING SECTIONS 

When the new column is added to the project, the column is presented in two views (front and right 

view) and with single section drawn in the views. This kind of presentation should be suitable for typical 

monolithic columns with equal longitudinal reinforcement on the whole height and with rectangular 

or round section. However, for columns with other sections or more complicated longitudinal 

reinforcement, two views and one section may be not enough. Therefore, there is always the 

possibility to add the new View from four available Views and set up the new section on any column 

height. The following five functions, available from main toolbar have been designed for this purpose: 

 - Insert Front View,  - Insert Rear View,  - Insert Left View,  - Insert Right View,  - Insert 

Section. Within the single project you may insert into a drawing few the same or different Views or 

Sections. After inserting into a drawing, always only one View or Section is active (the one with darker 

frame), it means that you can edit column model in this View or Section and add elements assigned to 

this View or Section, e.g. dimensions or descriptions. To change the active View/Section, double click 

on appropriate View or Section name in Project Manager "tree" or run function  - Activate selected 

construction View from the main toolbar. The toolbar function of switching active View has the 

additional feature, which maintains selection of reinforcement from the previously active View, 

provided that this reinforcement in the newly activated View or Section is visible. After selecting this 

function from the toolbar, point the mouse cursor on the View/Section, which you want to activate 

and click on any point within the frame of this View/Section. When you select the frame of inserted, 

active View or Section, four anchors enabling the user to resize the View area and one anchor (in the 

left, bottom corner of the frame) enabling the user to move the whole View within the drawing. Along 

with the View all the model elements and elements assigned to the View (dimensions and descriptions) 
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are moved. The frames of individual Views and Sections may overlap each other. In this case it is 

important to avoid overlapping of elements within such a frames (presented model, descriptions, 

dimensions etc.). The name of the View, name of the element present in the View and the quantity of 

the elements with this name included in the reinforcement steel lists. This description and frame are 

invisible in plotting by default. The titles for individual Views as well as other annotations, e.g. scale or 

quantities supposed to be visible in the printed document, may be entered by the standard text 

entering function available in CAD applications. During insertion of the Section or after selection of the 

existing Section frame, using the insertion bar or task bar you may open Properties window for the 

section and configure graphical representation of the section as well as its symbol. In Properties 

window it is also possible to set View depth for stirrups, i.e. depth to which the stirrups will be visible 

in the particular View. This option is set by default to 40 cm and its change enables the user to control 

stirrups visibility. The following elements are always visible in the Section inserted in the drawing: cut 

out outlines of column section, cut out longitudinal reinforcement rebars and transversal 

reinforcement rebars included in View depth for stirrups. 

 

Fig. 7 Element Properties window for Section 

3.5. INSERTING COLUMNS 

3.5.1. Setting up the column shape – function Insert column 

The basic method of column model creation is step-by-step defining of its elements: column shape, 

longitudinal and transversal reinforcement. Use function -  Insert column to define column 

geometry. When it is activated, you may optionally select the drawing template on the displayed 

Column structure insertion bar and click on Properties button. 

 

Fig. 8 Properties button on the Column structure insertion bar 

 Element properties: Column structure dialogue box opens. 
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Fig. 9 Element properties window: Column structure 

In the window displayed, the user should enter the column name, reinforcement cover, column 

quantity, height, concrete class and, in case of rectangular and round section, geometrical dimensions 

of section depending on its type.  Note, that the specified column quantity will be used to calculate (by 

multiplication) reinforcement steel list quantities for individual column or whole drawing. In case of 

designing the last level column in frame configuration, it is also necessary to indicate the direction of 

main frame plane, against transoms of which the outside longitudinal reinforcement of column will be 

bent. Via button Cross-section you may choose one of the available column section shapes: 

rectangular, round or other. The geometrical dimensions of rectangular and round sections are 

entered directly into column Properties window. In case of other, less common shapes of section, push 

cross-section button Other and define type and section dimensions in the separate window. If the 

column section other than rectangular or round is selected, the column Properties window will show 

the third icon with the selected cross-section shape. 
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Fig. 10 The dimension definition window for column section shapes other than rectangular or round 

When the column parameters are set in Properties window, two Views and one section will be inserted 

by default into the drawing in the selected localization. However just the one of them will be active, 

i.e. ready for insertion of other elements. After insertion of the column you may also insert two other 

Views; this operation is generally dedicated to columns with section other than rectangular or round. 

The active View of the column is indicated with black outline. Simultaneously only one View or Section 

of the column concerned may be active.  
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Fig. 11 Tow Views and one Section of the rectangular column, and four Views and one Section of T-
section column. 
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3.5.2. Inserting adjoining elements 

3.5.2.1. Top transoms 

The adjoining elements in form of transoms may be added to the column at its height, in any direction 

perpendicular to the column axis. This is realized with function  - Insert transom. When it is 

activated, you may adjust Properties of the transom in transom insertion bar. 

 

Fig. 12 Transom - element Properties window 

These includes transom parameters such as: visible transom length, type of its end (cut out or not cut 

out), diameter of stirrups in transom, value of reinforcement cover for transom, transom dimensions 

and concrete class. The transom width, when it is inserted into the model, is automatically adjusted to 

the suitable dimension of column section and cannot be changed in this mode. The user is able to 

freely change the width after insertion of the transom from Properties window. The type of the 

transom end and possibility to place it in any point of column height enable the user to potentially 

design columns with short cantilever (reinforcement of such a cantilever should be designed 

individually, rebar-by-rebar). The Application allows the user to add only rectangular transoms to the 

column, in two perpendicular directions and perpendicularly to the column axis. When adding 

transoms to the columns you must keep in mind that in case of last level columns (if upper level column 

is not present), the column longitudinal reinforcement will be bent to the transoms in the plane of 

main frame. This reinforcement can be bent only if the transom upper edge will perfectly match in the 

direction of main frame with upper edge of the column inserted into project. In other cases, the 

automatically overlapped reinforcement of the column will reach the column upper edge, or in case of 
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upper level column, will be inserted into this column. In the edition mode, also the transformation 

point change is available for selected transom in Properties window, e.g. during change of transom 

height (by default, it is the upper point of transom). 

3.5.2.2. Upper level column 

Besides the column adjoining elements in form of horizontal transoms, also the adjoining element in 

form of upper level column may be added. This is done with function  - Insert column of upper level.  

Properties window for upper level column is analogical as for transoms and contains similar 

parameters, such as: visible length of upper column, type of its end (by default: Cut out element end), 

diameter of stirrups in upper column, value of reinforcement cover for upper column, column 

dimensions and concrete class. 

 

Fig. 13 Properties window for upper level column 

The upper level column inserted in the project must always have the same shape of section like the 

column being designed, however for the columns with rectangular or round sections it may be the 

column with the same shape of section but with smaller dimensions (in this case the longitudinal 

reinforcement of column is bent into the upper level column). If the column with other section than 

round or rectangular is being designed, the upper level column being added must have exactly the 

same type of section and exactly the same dimensions as the column being designed. If the upper level 

column is used and has the same dimensions as the column being designed (or bigger dimensions - in 

case of rectangular or round section), the longitudinal reinforcement from the column is inserted into 

the upper level column to the anchoring depth, independently of adjoining transoms presence and 

their quantity. If the upper level column with rectangular or round section is used and has dimensions 

smaller than the column being designed, the longitudinal reinforcement from the column is bent into 
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the upper level column to the anchoring depth, independently of adjoining transoms presence and 

their quantity. In this case the bending of reinforcement into upper level column is done at the height 

of upper adjoining transoms (if any). If the upper adjoining transoms are not used, the reinforcement 

is bent on the length which provides bending angle of 1:3. In this case stirrups on the bending length 

will be automatically adjusted to the full dimensions of the column section including the cover. In case 

of adding adjoining element in the form of upper level column, the geometrical axes of column being 

designed and adjoining column will coincide in every case. 

3.5.3. Automatic designing of reinforced column on the basis of calculation 

ArCADia-REINFORCED CONCRETE Application features function of importing data from calculation 

applications: Constructor – REINFORCED CONCRETE COLUMN PN-EN and EuroFerroConcrete module 

of R3D3 3D Frame and R2D2 2D Frame software and automatic generation of column reinforcement 

drawing on the basis of calculation and transmitted data. After running of calculation in Constructor 

Reinforced Concrete Column PN-EN module, open Configuration of reinforced concrete element 

export by clicking on ArCADia button at the bottom left corner of Report configuration window. 

 

Fig. 14 Running data export to ArCADia software from Reinforced Concrete Column PN-EN module 
of Constructor software 

Similarly, in R3D3 and R2D2 software, during individual dimensioning of rebar selected in 

EuroFerroConcrete module, ArCADia button which opens Configuration of reinforced concrete 

element export window is located at the bottom left corner of simple View of element reinforcement 

window. 

 

Fig. 15 Running data export to ArCADia software from EuroFerroConcrete module of R3D3 or R2D2 
software 
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In these both cases opening of the export window results in displaying of dialogue subwindow which 

enables the user to specify geometrical data designed for export and selecting the export method. 

 

Fig. 16 Configuration of reinforced concrete element export window in Reinforced Concrete Column 
PN-EN and EuroFerroConcrete module 

In the configuration window you may select the type of element designed for export (currently it can 

be only a column), specify the method of column calculated height representation on the drawing (in 

axis or between supports), select and specify the dimensions of elements adjoining from top and 

bottom and define whether the longitudinal reinforcement is to be matched to the upper adjoining 

elements automatically or not. By selecting the column height in the support (transom) axis the user 

defines that the column calculated height will be represented on the drawing in the axis of the highest 

bottom and upper transom. By selecting the column height between the supports (transoms), the user 

defines that the column calculated height will be drawn from the upper edge of bottom transom to 

the bottom edge of higher upper transom. Selection of the adjoining elements and their dimensions 

in the form of column and upper transoms will result in transmission of data regarding these elements 

and dimensions to a graphical software in order to drawn them properly and determine appropriate 

column height. The adjoining elements in form of bottom transoms are not drawn in a graphical 

program - they are just used to determine appropriate height of the column on the drawing. The 

adjoining element widths are by default set as equal to the width of column being calculated. The 

automatic matching of longitudinal reinforcement option makes the longitudinal reinforcement of 

column to be automatically bent or inserted into the upper adjoining elements. This function is 

effective only for the most common columns with round or rectangular section. If the automatic 

matching of longitudinal reinforcement option is deselected, the reinforcement will be exported to 

ArCADia exactly in the form determined in a calculation application. Two export buttons are located 

at the left bottom corner: one is for direct export to ArCADia software, the second one is for saving 

the drawing data in XML file, which may be loaded into ArCADia drawing any time in the future by 

using function  - Insert complete column from xml file from the top toolbar of the program. In order 

to use the direct calculation data export function from Reinforced Concrete Column PN-EN or 

EuroFerroConcrete application, you must open a CAD software (ArCADia-INTELLICAD or AutoCAD) 
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with preinstalled full version of module ArCADia-REINFORCED CONCRETE COLUMN before running 

export function with the button. 

3.5.4. Copying of column between documents/files or within single document/file 

The Applications supports the function of copying completed columns between different documents 

or within a single file. This function enables the user to create new project using elements (columns) 

copied from previously completed multiple projects, which can be further suitably modified by the 

user. The column may be copied in form of complete model along with the reinforcement designed. 

The copy function is activated in the Application with standard method employing the clipboard. It 

means that you must select the column you want to copy, press CTRL+C keys, switch to the new 

document or stay in the same document, press CTRL+V keys and point on the localization within the 

drawing, where the copied column is to be placed. In order to copy complete column within the single 

drawing or between documents, at least the outline of the column being designed must be selected in 

the active View before copying it into the clipboard. Selecting of other elements in the View does not 

effect on the column copying method. Along with the column also the other column's elements are 

copied to the clipboard, such as: adjoining elements, longitudinal and transversal reinforcement, linear 

dimensions, rebars descriptions and all its Views and Sections. The copy function using the clipboard 

does not copies a drawing elements, which are not included in the particular Views and Sections, i.e. 

reinforcement steel list and rebar details. It is not possible to copy to the clipboard the following items: 

adjoining elements, reinforcement and its descriptions, and dimensions. 

If standard copy function available in CAD software is used, such copying is possible only within a single 

document. In such a case, in order to copy the complete column along with all its elements, Views and 

Sections, before using copy function the user must select at least the outline of column being designed 

in the active View. In order to copy the reinforcement, the user must select just the rebars and before 

using the copy function must check if the option of automatic matching available in Properties window 

is disabled for these rebars. After selection of the View or Section frame, the copy function enables 

the user to insert another, the same View or Section within the same structural element (column). 

3.6. REINFORCEMENT INSERTION 

3.6.1. General characteristic of reinforcement designing 

The component reinforcement designing rules applied in this Application are in line with requirements 

of EN 1992-1-1 Eurocode 2: September 2008. The following elements of rebars the Application inserts 

automatically during reinforcement designing: 

 Stirrup hooks angled at 90 or 30 degrees, depending of settings in the Application options. 

 Bend radii for rebars (if the option of taking into account of bend radii is enabled in the 

Application Options). 

 Anchoring lengths of longitudinal rebars when the reinforcement is inserted into transoms or 

upper level column. 

Straight hook length for stirrups has been set to 10x diameter, but not smaller than 7 cm. For stirrup 

hooks bent at angle of 30 degrees – 5x diameter, but not smaller than 5 cm. The automatic hooks are 
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used only for stirrups, for other rebars, since the Eurocode concerns only reinforcements made of 

ribbed steel with yield strength from 400 to 600 MPa, the automatic hooks are not used. 

Bend radius calculation procedure for stirrups is based on the rule defined in 8.1N table of EN 1992-1-

1 Eurocode 2, and for other rebars the additional checking of minimum bend radius according to 

equation 8.1 of the above standard has been applied. 

The longitudinal rebars anchoring lengths in adjoining elements (transoms or upper level column) has 

been calculated using equations 8.10 and 8.11 of EN 1992-1-1 Eurocode 2. 

The sequence of reinforcement insertion into the column is not important. However, because the 

reinforcement being inserted is adjusted to the column section shape, or, to be more precisely, to the 

value of reinforcement cover specified in the column Properties, it is recommended to keep in mind 

the rule stating that the longitudinal reinforcement is inserted after the transversal reinforcement. 

Otherwise, if the automatic longitudinal reinforcement is inserted first, it will be arranged with the 

offset equal to the cover value against all the section edges, and next, after insertion of stirrups it is 

shifted again by the stirrup thickness in the direction of column inside. This situation occurs when the 

longitudinal and transversal reinforcements are overlapped in the automatic mode. Therefore it is 

important to keep in mind the rule stating, that if you want to disable automatic mode for stirrups, 

you must disable automatic mode for longitudinal rebars first. Otherwise the automatic longitudinal 

rebars once again will be arranged with the offset equal to the cover value against outside edges of 

the section while the thickness of stirrups with disabled automatic mode will be not considered. 

3.6.2. Inserting transversal reinforcement into column 

It is recommended to start the insertion of reinforcement into the column in the current version from 

transversal reinforcement in form of stirrups. For this purpose the Application is provided with two 

similar functions:  - Insert single stirrup and  – Insert stirrup block.  The firs one inserts single 

stirrup into the model, while the second one inserts stirrup block on the defined length (generally also 

with defined span). Since the stirrups are generally inserted in blocks, the optimal solution would be 

insertion of stirrups in one of active Side Views. It is also possible to insert the single stirrup in the 

Section; in this case this stirrup will be inserted in the place of location of the Section on the column 

View. The insertion bar is identical for both functions, and contains: definition of the insertion point 

on the stirrup (left, centre and right point), graphical options: Reference, Between points (centre) and 

Between points (percentage) and access to dialogue box Stirrups properties.  

 

Fig. 17 Insertion bar for stirrups 

For insertion of automatic stirrups only the centre insertion point is available. To change this setting 

deselect automatic insertion option in Stirrup properties window. During insertion of stirrup or stirrup 

block you may use characteristic points of CAD applications and additional graphical option form the 



ArCADia-REINFORCED CONCRETE COLUMN   User Manual    

Working with the Application 

 
30 

 

insertion bar, described above. Click on Properties button to open dialogue box Element properties: 

stirrup block. 
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Fig. 18 Element properties window for two- and four-legged stirrups 

You must first define the type of stirrup block (two- or four-legged) in Properties window.  Next, define 

if the block size and location within the Section is to be determined automatically. If Yes, the 

Application will adjust the stirrup shape to the column section automatically, maintaining their 

appropriate cover. In such a case the only thing you must specify is the stirrups diameter and their 

yield strength, and in case of four-legged stirrups you must additionally specify the stirrup width or 

overlap width and rotation of the stirrups in the plane of the column section. If the automatic insertion 

option is enabled, you must specify the length and width of the single stirrup or stirrup block by 

yourself. Parameters: quantity in block, span and transformation points, available for edition when 

Properties window is being opened for the block inserted already.  

When the single stirrup or stirrup block properties are defined, point the single stirrup or stirrup block 

localization within the column model or the origin of the block being inserted. When inserting the block 

of few stirrups, after pointing their origin the enhanced insertion bar will be displayed complemented 

with additional options for precise specification of the block end point, stirrup span or their quantity. 
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Fig. 19 Insertion bar for stirrup block 

In such an enhanced insertion bar the user may decide whether the stirrup span (the quantity is the 

result) is to be maintained on the given length covering the stirrup block, may specify the stirrup 

quantity (the span is the result) and whether the external stirrups are to be inserted with the stirrup 

block or not.  

After insertion and selection of the stirrup block, the task bar with the following three functions will 

be displayed:  - Explode block of stirrups into individual stirrups,   -Insert rebar details, actually 

stirrups, in this case ("extracted" rebar) and  - Insert rebar description (stirrup block, in this case). 

 

Fig. 20 Task bar for stirrup block 

For the active Section, the task bar for four-legged stirrup or stirrup block is enhanced with the extra 

function  - Adjust width of four-leg stirrup overlap enabling the user to adjust the overlap to the 

longitudinal rebar positions in the column section. This function operates for four-legged stirrup 

selected in the column section. It has effect on the all stirrups of the same type used in the column, 

located above and under the selected block. Function  - Adjust width of four-leg stirrup overlap is 

not available in the task bar for four-legged stirrups in any of active Side Views.  

 

Fig. 21 Task bar for four-legged stirrups with Section active 

The similar situation occurs when the stirrups are inserted into the round section columns. In this case 

only the single overlap stirrup or stirrup block with diameter adjusted in the automatic mode are 

available. For the active section, the task bar for round stirrup or round stirrup block is extended with 

extra function  - Adjust stirrup hook position, which enables the stirrups to be rotated around the 
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column axis and to be positioned such a way, which ensures the hook bending on the correct 

longitudinal rebar of the column. 

 

Fig. 22 Task bar for round stirrups with Section active 

In case of other shape columns, the automatic stirrups (single or in blocks) are overlapped in a single 

operation in the single column section branch, depending on the View which is active at that moment. 

By appropriate switching of the active Views, you may distribute the stirrups in the every column 

branch.  

3.6.3. Inserting longitudinal reinforcement into column 

When the transversal reinforcement insertion has been completed, you may start with the insertion 

of longitudinal reinforcement into the column. For this purpose the Application has been provided 

with the following two options:  - Insert single automatic rebar and  - Insert automatic rebar 

block.  Both functions are dedicated to insertion of standard longitudinal reinforcement into columns. 

The optimal solution available in the Application is insertion of automatic longitudinal rebars in the 

active column Section. The longitudinal rebars may be also inserted in the active column View; in such 

a case they will be distributed on the View wall, which is nearest to the Observer. After running one of 

the above functions, you may switch from Insertion bar to Properties for the rebars being inserted. 

 

Fig. 23 Element properties window: Rebar in insertion mode 
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You may specify the rebar diameters, steel yield strength in Properties window. The shape of 

longitudinal rebars in the automatic mode (default for rebar insertion) will be adopted to the shape of 

column being reinforced, with the adjoining elements being considered. It means that in case of 

adjoining element presence, e.g. in the form of upper level column, the longitudinal rebars will be bent 

or inserted on the anchoring length into this column (depending on its dimensions). However, if the 

column being reinforced is on the last level and there is no upper level column, the longitudinal 

reinforcement will be bent on the anchoring length into the opposite, upper horizontal transoms in 

the plane of main frame. In this both cases, the anchoring length is calculated automatically as the 

length inserted into the upper column or bent into the transom, measured from the bottom of lover 

transom. If the column being designed has no adjoining elements at the upper end, automatically 

inserted rebars will be straight on the whole column height with necessary upper and bottom cover 

maintained. When the reinforcement properties are specified, during insertion of the single rebar 

point directly its localization in the active Section or View. Select  - Insert automatic rebars group 

option, and then point the localization of the first rebar of the block, in the extended Insertion bar 

specify the rebar quantity for the selected length (Maintain constant quantity option) or the rebar 

quantity will be calculated for the constant span (Keep constant distance). Also, similarly to stirrup 

block, you may additionally select Do not insert external elements option. 

 

Fig. 24 Extended insertion bar for rebar block 

When the above parameters are set properly, you may point localization of the last rebar of block on 

the active View or Section. In order to reinforce rectangular column symmetrically, to have 5 rebars 

on the opposite sides and 3 rebars on other sided, insert 5 rebars from one corner to the second while 

having option Maintain constant quantity of 5 pcs enabled. The same applies for insertion of 5 rebars 

on the opposite side. Next, in the other sides insert 3 rebars (in the same way, from the corner to the 

corner) while having option Do not insert external elements enabled. As you can see in the above 

description, the most convenient way for automatic insertion of rebars is to use the column Section. 

As opposed to the stirrup blocks, the automatic rebar block is visible only during its insertion. After 

insertion, each rebar of the block may be considered individually.  

When the automatic rebar or rebars are inserted into the drawing, you may select them and open 

Properties window from task bar. The window will feature additional mark for disabling the mode of 

reinforcement adjustment to column – Disable automatic adjustment to column. The operation of 

disabling the automatic adjustment of the rebar is irreversible, and when it has been chosen, the 

automatic rebar becomes rebar of any type, which may be freely modified. 
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Fig. 25 Element properties window: Rebar in edition mode 

In case of columns with section other than round or rectangular, the automatic rebars are inserted 

always only on the whole column height, without their automatic bending into transoms or insertion 

into upper level column. Similar to the stirrups, the longitudinal rebars may be overlapped in the View, 

in a single operation in the single column section branch, on the wall, which is nearest to the Observer. 

Therefore, for these type of sections it is recommended to create a reinforcement model using all the 

available Views. The most convenient way of automatic longitudinal rebar insertion into sections other 

than rectangular or round (however, it is also the most convenient way for these sections) is insertion 

of the longitudinal reinforcement in the Section, where you have easy access to all walls of the section. 

3.7. INSERTION OF ANY TYPE REBAR AND REINFORCEMENT MODIFICATION 

Also the rebars of any shape may be inserted individually into the columns. This is realized with 

function  - Insert user-defined rebar shape. When the function is activated, you may switch from 

Insertion bar to Properties window for the rebar being inserted, where you may specify its diameter 

and yield strength. This Properties window appearance is similar to the Properties window appearance 

for automatic rebar; the only exception is that in the insertion mode nor edition mode there is no 

possibility to deselect automatic adjustment to column, which as rule is not effective for such a rebars.  

When the rebar parameters are specified in Properties window, you may start defining the rebar shape 

- it is realized by pointing successive points of polyline using for this purpose graphical tools available 

in Insertion bar and standard tools available in CAD software, such as: precise relative coordinates, 

snapping points, etc. Free-shape rebar is inserted always into the active View (Section) and is drawn 

automatically on other Views and Sections. When defining free-shape rebar, each of its bend is 

rounded with bend radius the suitable for the given rebar diameter, according to rules set out in the 
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Application Options. After selection few rebars in the model, few operation will become available in 

the taskbar. 

 

Fig. 26 Task bar appearance after selection of few free-shape rebars 

These are, from the left: 

  - The function inserting details of the rebars selected (insertion of extracted rebars). 

  - The function inserting descriptions for every rebar selected on the single common 

reference line (select the View in which the description reference lines are to be inserted and 

then point the reference line localization). 

If only one free-shape rebar is selected, the list of available operation for this rebar is much longer. 

 

Fig. 27 Task bar appearance after selection of single free-shape rebar 

In such a case three more, extremely important operations are added: 

  - The function inserting successive segments on the one end of the rebar selected (select 

the one end of rebar and then select successive point of polyline, similar to free-shape rebar 

insertion). 

  - The function deleting the first or the last segment of rebar selected (point on the first or 

the last rebar segment). 

  - The function modifying any segment of rebar selected (select any segment of rebar 

selected and then point on the end of segment, which is to be changed, and enter or indicate 

on the drawing the target length of the segment being modified). During modification of the 

selected rebar segment, all the others segments located after the selected end will be 

translated simultaneously. 

Similar operations to the above described will be available for automatic rebar with automatic 

adjustment to column option disabled. The free-shape rebar is inserted always into the active View, 

by default in the plane crossing with the column section axis, or, in case of active Section, in the section 

plane. The rebars inserted into model in this way (in any View/Section selected by the user) may be 

further deleted, moved, copied, rotated, mirrored with the use of CAD tools, coordinates and snapping 
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points. Correct use of the tools available for the free-shape rebar, such as: rebar insertion, View 

switching and adding successive rebar segments enables the model to be enriched with spatial rebars. 

 

Fig. 28 Example of free-shape spatial rebar in 3D View 

3.8. INSERTION OF REINFORCEMENT DETAILS 

Each rebar inserted into the model may be "extracted" on the reinforcement drawing in the form of 

rebar copy with details (dimensions) of its structure and annotations. For this purpose the Application 

is provided with two functions:  - Insert rebar details and  - Insert details for all rebars. Both 

functions are available from the Application main toolbar. Additionally, the firs one function is available 

from taskbar for single automatic rebar, free-shape rebar and stirrup block. After selection of  - 

Insert rebar details and selection of the rebar in the model, for which the function is to be applied, 

point the localization on the extracted rebar drawing. The extracted rebar drawing is not the model 

object (it is not visible in the 3D View), is not included into reinforcement steel list and is not associated 

with any View nor Section. The rebar detailed drawing, along with the rebar geometry includes: 

automatically generated rebar number, its diameter, total length, lengths of particular segments, 

dimensioned bend radii and arc lengths. The method of presentation for these elements is dependent 

on the settings in the Application Options window. In the element Properties window: For Rebar 

details you may select font size. 
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Fig. 29 Properties window for rebar details 

Function  - Insert details for all rebars operates in the similar way to insertion of details for single 

rebar, however in this case you do not have to select rebars for which the details are to be inserted - 

the Application automatically finds all the rebars o any shape used in the drawing and generates 

extracted rebars for all these rebars in a single operation. Within the extracted rebars you may insert 

into the drawing few identical rebar details, and their quantity do not effect on the quantity of rebars 

in the model and steel list. Each modification of the actual rebar in the model (change of dimension, 

shape, diameter, etc.) is automatically appropriately represented in the extracted rebar associated 

with the rebar modified. 
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Fig. 30 Example drawings of extracted rebar details 

After selection of any drawing with rebar details, the three base points enabling the user to change 

the extracted rebar localization and to independently change its description localization and the 

description length in relation to the length of the rebar extracted become available. 

3.9. INSERTION OF REINFORCEMENT DESCRIPTIONS IN VIEWS AND SECTIONS 

For rebars inserted into individual Views and Sections it is possible do insert the reinforcement 

descriptions. For these purpose the Application has been provided with function  - Insert rebar 

description available from main toolbar.  After selection of this function, point the rebar or rebars 

(identical or different) in the active View or Sections, for which the description is to be inserted. Next, 

select the View or Section, in which the description is to be inserted. It is possible to choose another 

View than the one in which the rebars were selected. The reference line of description being inserted 

refers always to all the rebars selected, and when different rebars were selected, the reference line 

takes the form of a list, in which every rebar with different number and shape is described in the 

separate line of the list.  The last operation during insertion of descriptions is pointing on localization 

for the description being inserted on the drawing. The rebar descriptions are not the model elements, 

but as opposed to the inserted rebar, they belong to the particular View and are deleted or hidden 

with this View. When inserting a rebar descriptions into the drawing, you may open their Properties 

window from taskbar. 
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Fig. 31 Taskbar appearance during insertion of rebar descriptions 

 

Fig. 32 Properties window for rebar description 

In this window, along with font resizing you may define the appearance of particular description. To 

do so, push Description appearance button, which opens additional window for configuration of 

description appearance.  

 

Fig. 33 The window for configuration of description appearance 

By deselecting the option Description on reference line you may remove the reference line from the 

description. You may also decide which elements will be included in the description by selecting and 

moving the appropriate items from the left to right panel, or vice versa. The following items are 

available: Label (with rebar number), Quantity, Diameter, Span and Length. By default, the following 
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items are selected in the Application for the longitudinal rebars: Label (with rebar number), Quantity, 

Diameter, and for stirrups these are: Label, Diameter and Spacing. The option that allows to insert the 

descriptions of the rebars can be activated for the automatic rebars or any rebars from its task bar. 

 

 

Fig. 34 Two identical sections with different types of rebars description 

3.10. INSERTING REINFORCEMENT STEEL LIST 

There are two different methods to insert the reinforcement steel list using functions of the main 

toolbar. Using  - Insert list of steels used in structural element function you may insert the list for 

currently active structural element, multiplied by the quantity of this elements entered by the user in 

Properties window of the column. 
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Fig. 35 Example of reinforcement steel list for selected element (column) 

The second function enabling the reinforcement steel list to be inserted into the project is  - Insert 

list of steels used in project option. After selecting it and specifying location of the list in the drawing, 

the inserted list will include summary of all structural elements used in the drawing, multiplied by its 

appropriate quantities defined in the Properties window of the individual columns. 

 

Fig. 36 Example of reinforcement steel list for entire project and all columns arranged within it 

3.11. INSERTING COLUMN GEOMETRY DIMENSIONS 

The most convenient way to insert the geometrical dimensions of the column into the drawing is to 

use the dimensioning provided by ArCADia. Then, the dimensions inserted in a such way will belong 

to the appropriate Views and Section of the column and altogether with them may be removed, hidden 

or moved. The dimensions inserted into the drawing are not the column model elements but belong 

to its individual Views and Sections. Insertion of the dimensions is always performed in the active View, 

using  - Insert user-defined dimension function from the main toolbar. After running this function, 
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you may choose orientation of dimensions: vertical and horizontal (default option) or parallel to points 

selected on the drawing. 

 

Fig. 37 Insertion bar for geometrical dimensions 

Next, select successive points of the structure being dimensioned. When the points are selected press 

the right mouse button and specify the location for the dimension on the drawing. After it, the linear 

chain dimension associated with the selected points will appear in the selected localization. When 

parallel dimensioning of several points which are not arranged in line is selected, the parallel 

dimension will be offset against to the line determined by the first and the last point being 

dimensioned.  

By opening the Properties window for the dimension being inserted or already inserted dimension 

from Insertion bar or taskbar, you can define the dimension style and font size. 
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Fig. 38 Properties window for dimensioning 

The units of the linear dimensions can be selected between cm and mm depending on the global 

settings made by the user in the Options window of the Application. The dimensions inserted into the 

drawing may be moved (using the anchors visible after selection of dimension) and deleted. 

3.12. EXAMPLE DRAWINGS OF TYPICAL COLUMNS CREATED IN ARCADIA–
REINFORCED CONCRETE COLUMN APPLICATION 
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Fig. 39 Example drawings of the columns and 3D model view created in ArCADia–REINFORCED 
CONCRETE COLUMN application. 

 


